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Description 3DIM Tool 2.3.1

Purpose and application

The “3DIM Tool” software is utilized for programming electronic control gears (ECG)
from OSRAM equipped with the 3DIM functionality. The connection between PC and
ECG is established via the “DALI magic” hardware interface from OSRAM.

OSRAM 3DIM ECG families are:
e POWERTRONIC® 3DIM ECG for high pressure discharge lamps
e OPTOTRONIC® 3DIM ECG for LED modules

What is 3DIM?

3DIM embodies the combination of three different control and dimming options in one
OSRAM ECG.

DALI® - Digital communication

3DIM ECG can be integrated in bidirectional telemanagement systems via the DALI®
interface. DALI® is a manufacturer-independent, well-proven communication standard
specifically developed for lighting applications.

StepDIM — Midnight step-down / Half-night switch

StepDIM is used in installations, where a dedicated high voltage control line (switched
phase) in addition to the mains supply is available. This additional phase is connected
to the StepDIM port (SD terminal) of the ECG. For StepDIM two switching logics are
available:
* StepDIM

— Control line not live equals default value (Power-on level)

— Control line live equals Dim level
* StepDIM inverse

— Control line live equals default value (Power-on level)

— Control line not live equals Dim level

AstroDIM — Dimming without external control

AstroDIM is ideal if there is no way to dim the ECG by dedicated control lines (DALI®
or StepDIM interface not available) due to a lack of infrastructure. It allows autonomic
dimming in two steps via an integrated time actuator (no real time clock).

More information on 3DIM as well as a detailed application guide is available at
www.osram.com/3dim.

Note:

The 3DIM Tool is used only for the configuration of StepDIM, AstroDIM and some
specific parameters for OPTOTRONIC® constant current ECGs. It is not possible to
send individual DALI® commands with 3DIM Tool. For this purpose OSRAM offers
the DALI wizard software, which is also used in combination with a DALI magic.
www.osram.com/Ims-magic
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3DIM Tool 2.3.1

Installation

System requirements

The minimum system requirements for the 3DIM Tool are:
* OSRAM DALI magic incl. USB cable
¢ A PC or notebook with the following specification
— Pentium M processor
— 1 GB main memory
— Windows XP, Windows Vista or Windows 7 (both 32 or 64-bit)
— 40 MB hard disk memory

— Monitor with a resolution of 1024x768 or 1024x600 pixels, the recommended
zoom factor is 100 %

— Afree USB 2.0 port

Software installation

3DIM Tool can be downloaded via www.osram.com/3dim. After the download, the
3DIM Tool appears as ZIP file in download folder.

Two different versions of the 3DIM Tool can be installed:
* Normal mode: All configuration features are available.
* Manufacturing mode: Only prepared configurations can be uploaded.

Normal mode is designed for creating configurations as well as testing 3DIM and
OPTOTRONIC® Config parameters during luminaire development, or installation
design. Manufacturing mode is set-up for usage in production, only enabling the
upload of a predefined configuration. It is recommended to install only manufacturing
mode on PCs utilized in production.

Step | Activity

1 Double-click the ZIP file.

2 Within the ZIP folder, double-click the setup file. The installation wizard
appears.

3 Follow the instructions of the installation wizard.

3DIM Tool is executed via “Start” - “All Programs” > “OSRAM” > “3DIM Tool” or by
double-clicking the desktop icon (normal or manufacturing mode).
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Installation

3DIM Tool 2.3.1

Hardware installation

To program OSRAM 3DIM ECG(s), a connection between ECG(s) and PC must be
established first. It is possible to program up to 64 ECGs of the same type simultane-

ously.

Step

Activity

1

Connect DALI magic and PC with the enclosed USB cable.

2

If more than 4 ECGs are programmed simultaneously, the external 6 V
DC power supply for the DALI magic must be used™.

Connect the OSRAM 3DIM ECG to mains.

Note:

Connect the DALI® terminals of the DALI magic with the DALI® inputs of
the ECG(s).

It is recommended to disconnect the USB connection between PC and DALI magic
only after closing the 3DIM Tool.

Wiring diagram

3DIM ECG

« DALI
A\Y

Optional
power-supply

3DIM ECG

up to 64 devices

DALN

1 Up to 4 ECGs can be programmed without external power supply only if no other USB devices are connected to the PC (USB port

overload needs to be avoided).
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3DIM Tool 2.3.1 User interface

User interface

Basic layout

Header  Menu bar Tool bar 3DIM ECG and mode selection

[ Temt, i - DSRAM 301 Tool

(Pl Trafer  Monkoing | Reset  Seftings B+ e

— 3DIME &

OSRAM 0N ECG | 0T 1507220 4V700 TDWLT+ € SHIH e | SepMABDIMDAL v
gt} Ratrafi | coTOmMOHICE Conig -
‘Cowrsa of tha night
Smings per year up to 29 %
althe 0N ECH
tocaton [F]bem v
Drsphgh s tene =
st [z1zama -
00 Blowmss o kel 00 & X
0 Dimlerl] ———————————
50 S b * ] H
T Erd e 1] B
= Dirnlevel bl & x
B [T
EW Dirnbervel 2 enabied =
a0l T (1] 2
Erl e L] 2
x
Dimlevel £  *
10
i acle time: 000 -
273 TS5 06 17 18 1% 20 21 2 23 00 01 02 03 04 05 06 07 08 09 10 11 2
ECG location time [hrs]
" The rest 0 Sapye 0nd actusl wwitch-0n / -of timen of he sree! ighty.
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Menu bar

The basic functions are available via the menu bar. Submenus or dialogs are opened
by clicking an entry in the menu bar. The menu contains the following elements, each
with the listed sub items.

File
New configuration Creates a new configuration.
Load configuration... Loads an existing configuration.
Save Saves the current configuration.
Save as... Saves the current configuration under a new name.
Exit Closes the software.
Transfer
Upload to ECG(s) Sends the current configuration to the ECGs.
Download from ECG Displays the configuration of the ECG connected (only
possible with one ECG) within the user interface.
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User interface

3DIM Tool 2.3.1

Monitoring

Opens the Monitoring window.
Settings

Opens the Settings menu.
Reset

Reset 3DIM parameters

Restores 3DIM factory settings.

Delete AstroDIM power-on
history

Deletes AstroDIM operating hour memory.

Reset LED module opera-
ting time

Note:

Resets the LED module operating time to ,0“ (Only
possible for OPTOTRONIC® constant current ECQG).

Each reset requires a restart (disconnecting and reconnecting the power supply) of

the ECG.

Flag icon

Allows for selecting the GUI language. After the language has been changed, a
restart of 3DIM Tool is necessary.

Help Icon
About OSRAM 3DIM Tool... | Opens the About dialog.
Toolbar
The toolbar provides instant access to the most important features.
New configuration Creates a new configuration.
Load configuration... | Loads an existing configuration.
I Save Saves the current configuration.
|
$ Upload to ECG(s) Sends the current configuration to the ECG(s).
Download from ECG | Displays the configuration of the ECG connected
(only possible with one ECG) within the user inter-
o face.
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3DIM Tool 2.3.1 User interface

3DIM ECG and 3DIM mode selection

The three drop-down menus are used for selecting the utilized 3DIM ECG and opera-
tion mode.

3DIM ECG 3DIM mode

© e e

| CERAM J0IM ECG | 0T 15V2202400700 HMLT - £ 56 0IM made | SteplIMASGIIMATALL

Workspaces

The tabs are used to switch between “StepDIM”, “AstroDIM” and “OPTOTRONIC®
Config” workspaces. At any given time only workspaces are shown, which are sup-
ported by the chosen ECG and operating mode.

" StepDIM AstroDIM OPTOTRONICE Canfig

Status bar
At the bottom of the 3DIM Tool all information regarding the current state is displayed.
Communication state USB connection Status note Progress bar
Internal DALL voltage Communication . ‘Jﬂ;‘ 3DIMECG found 1 x OT'50/220-240/700 3DIMLT E | -

DALI magic power supply

DALI magic power supply
@ | No DALI® voltage, this is only displayed if no DALI magic is connected.

A yellow mark indicates that the DALI magic is only supplied by the USB port,
thus only 4 ECGs can be programmed simultaneously.

A green mark indicates that the DALI magic is supplied via the external power
supply, up to 64 ECGs can be programmed.

A red mark indicates that the voltage on the connection terminals of the con-
nected DALI Magic is higher than the maximum permitted DALI® voltage.

Communication state

[ ) ‘ A blue mark indicates communication via the DALI® line.

USB connection

S | DALI magic not connected to USB.

L ‘ DALI magic connected to USB.

Status note
The message displayed summarizes the current state and task executed.

Progress bar

During search, upload or download, the progress of the executed task is displayed
here.
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General Operation 3DIM Tool 2.3.1

Principle

3DIM Tool is designed to immediately visualise parameter changes made by the user.
This display provides the user with an indication how the 3DIM ECG will behave in
subsequent operation.

The steps described below can be carried out in any order, although for
OPTOTRONIC® constant current devices it is recommended to first set-up the
OPTOTRONIC® Config parameters.

Selecting ECG type and 3DIM mode

Note:
For a detailed description of the 3DIM modes, please refer to the 3DIM application
guide www.osram.com/3dim.

3DIM ECG 3DIM mode

© e e

CSRAM J01M ECG mu:'uuﬂll:i:mlr-r - 568 J0IM made | StenlIMiASGIIMDALL

3DIM ECG type
The utilized 3DIM ECG is selected via the left drop-down menu.

3DIM mode
Depending on the selected ECG different 3DIM modes (right drop-down menu) are
available. To be compliant with the DALI® standard, each 3DIM mode includes the
possibility to control the ECG via DALI® commands.
® StepDIM/AstroDIM/DALLI (wiring selection)
The wiring of the ECG decides whether StepDIM, AstroDIM or DALI® mode is per-
formed, after switching on the ECG. (For the different wiring schemes, please refer
to the ECG data sheet or the 3DIM application guide.)

¢ StepDIM/DALI
StepDIM as well as DALI® can be used.

® StepDIM inverse/DALI
StepDIM inverse as well as DALI® can be used.

* AstroDIM/DALI
AstroDIM as well as DALI® can be used.

* DALI
Only DALI® can be used.

10
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3DIM Tool 2.3.1 General Operation

StepDIM mode

Select the “StepDIM” tab to configure StepDIM. The workspace consists of the param-
eter setting frame and the visualization of the ECG behaviour.

StepDIM Parameter setting

Dhirn lewvel 1

Dvirin level

Dim fade time 181.0 =l =

StepDIM operation is defined by three parameters.

* Power-on level in [%]:
Output power level (in % of the nominal value of the ECG lamp combination), after
switch-on via mains. The settable minimum value is limited according to the capa-
bilities of the chosen ECG The Power On Level in the 3DIM Tool corresponds to the
DALI® Power On level and System Failure Level.

* Dim level in [%]:
Output power level (in % of the nominal value of the ECG lamp combination), after
the control wire is switched (SD state change). The Dim level may be lower, equal to
or higher than the Power-on level. The settable minimum value is limited according
to the capabilities of the chosen ECG.

* Dim fade time in [s]:
Transition time between Power-on level and Dim level and vice versa (only config-
urable for OPTOTRONIC® 3DIM ECG).

Note:

Both the Power-on level and the Dim level are set according to the logarithmical
dimming curve of the DALI® standard. For a detailed description, please see
IEC62386-102, table 9.1. If DIM level or the Power On Level is below the physical
min level of the ECG, the physical min level would be used.

XI1'2013 1"



General Operation 3DIM Tool 2.3.1

StepDIM Visualisation

Power-on level Dim level

100
a0

80

On Dim start Dim end Off

StepDIM: ECG behaviour during the night

Dim start Dim end

SD-Signal

StepDIM: Rendition of the SD state change in “StepDIM/DALI” mode

SD-Signal

Dim start Dim end

StepDIM: Rendition of the SD state change in “StepDIM inverse/DALI” mode

AstroDIM mode

Select the “AstroDIM” tab to configure AstroDIM. The workspace includes the setting
and visualization of the ECG operating location, as well as of the ECG behaviour.

Location selection

Note:
To configure AstroDIM the operation location of the ECG must be specified first.

To do so, either select a default location within the locations drop-down menu or cre-
ate a new location. Predefined location could not be maodified. In the case the location
data in the ECG is not matching with any predefined location “customized” will be
shown.

12
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3DIM Tool 2.3.1

General Operation

Operating location of the 30IM ECG

Location | ¥ |Testing Location

Change/Create location

Location selection

The coordinates and the time zone for each location could be visualized by moving the
mouse above the drop down menu arrow.

— Operating location of the 3DIM ECG

Location [y Muriich

Date

Daylight saving t

Lengitude: 11,63
Latitude: 4813
Time zone: (UTC+01:00)

23122013

Creating a location
To create a location, click the button to the left of location drop-down menu. The “ECG

location” dialog opens. The coordinates and the time zone for each location could be
visualized by moving the mouse above the drop down menu arrow

B ECG location

Location visualization

Location ting Location

Latitude ’EJUU Longitude 11.000 H

Time zone |[G AT+01:00] Belgrad, Bratizlava, Budapest, Ljubliana, Prag w |

[ Save ] [ Delete ] [ Cancel ]
Location name Latitude Longitude Time zone

XI1'2013
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General Operation

3DIM Tool 2.3.1

Each location is defined by the following properties:
* Location name

* Latitude

* Longitude

* Time zone

Latitude and longitude are entered in decimal form with up to four decimal places as
standard. Admissible input values for latitude are values between -65.000 and 65.000
for longitude between -180.000 and 180.000.

In addition to the decimal input, the coordinates can also be entered in degrees and
minutes, herefore the input method must be changed accordingly, within the settings
menu (see chapter “Settings”).

Coordinate examples:

Latitude Longitude Latitude as Longitude as
decimal value | decimal value
Munich 48°8'N 11°34'E 48.1397 11.5744
New York 40° 42'N 74°0'W 40.7127 -74.0058
Sydney 33°51'S 151°12'E -33.8500 151.2000

If the geographical coordinates for a given ECG operating location are not available,
they can be determined, amongst others, in the following ways.

Determining decimal coordinates via Google maps

Step | Activity

1 In your web browser, open the following website: http://maps.google.com/

2 Enter the location (i.e. the name of a city) you are seeking into the search
field and click “Search Maps”.

3 Right-click on the location of the ECG within the map and select “What's
here?” in the context menu.

4 The coordinates are displayed in decimal form as “Latitude, Longitude” in
the search field.

Determining coordinates via Wikipedia

Step | Activity

1 In your web browser, open the following website: http://en.wikipedia.org/

2 Enter the location (i.e. the name of a city) you are seeking into the search
field at the top right corner and confirm with the return key.

3 The Wikipedia entry of the location opens; the coordinates are displayed
in degrees and minutes directly below the search field. A left-click on the
coordinates opens a new browser window; here the coordinates are also
displayed in decimal form.

XI12013



3DIM Tool 2.3.1

General Operation

Create location
Step | Activity
1 Open the “ECG location” dialog.

2 Include location name, latitude and longitude.

3 During the input of the coordinates, a pre-selection of the time zone is
made. Please check if the time zone is correct and change it if necessary.
By default only one entry per time zone is available within the drop-down
menu. This can be changed within the settings menu.

4 Click “Save” to adopt the new location into the location drop-down menu.

Edit location
Step | Activity
1 Open the “ECG location” dialog.

Select the respective location within the drop-down menu.

2
3 Edit the location parameters.
4 Click ,Save*.

Delete location

Step | Activity
1 Open the “ECG location” dialog.
2 Select the respective location within the drop-down menu.
3 Click ,Delete”.

Selection of summer/winter time (daylight saving time)

Setting or removing the “Daylight saving time” tick only mark changes the visualisation
of the night lapse accordingly and the start and end times for the two dimming levels
and the selected day. The ECG paramters for the dimming profile are not affected..
This is to indicate how the device will behave during daylight saving time.

D aylight zaving time Fl

AstroDIM parameter setting

The AstroDIM operation is individually configured by means of the following param-

eters.

* Power-on level in [%]:
Output power level (in % of the nominal value of the ECG lamp combination), after
switch-on via mains. The settable minimum value is limited according to the capa-
bilities of the chosen ECG. The Power On Level in the 3DIM Tool corresponds to the
DALI® Power On level and System Failure Level.

* Dim fade time in [s]:
Transition time between Power-on level and Dim level and vice versa (only
configurable for OPTOTRONIC® 3DIM ECG).

XI1'2013
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General Operation 3DIM Tool 2.3.1

* Two dimming levels, with the second level being optional. Each level is defined by:
— Start time in [hh:mm]: Time at which the dimming level starts2.
— End time in [hh:mm]: Time at which the ECG changes to the next level?.
— Dim level in [%]:
Output power level (in % of the nominal value of the ECG lamp combination),
for the respective dimming level. A level must not necessarily be lower than the

Power-on level or the previous dimming level. The settable minimum value is
limited according to the capabilities of the chosen ECG.

Note:

Both the Power-on level and the Dim levels are set according to the logarithmi-

cal dimming curve of the DALI® standard. For detailed description, please see
IEC62386-102, table 9.1. If DIM level or the Power On Level are below the physical
min level of the ECG, the physical min level will be used.

Power-on lewvel

o

 Dim lesvel 1
Start tirme * 21:56 e
Erd tirne * 256 v
Dirn lewvel 4
r Dim level 2

Dirn levvel 2 enabled

i! i’

Stark time ™
End tirne * 200 -
Diirn Fade time 120 3 -

Energy savings display

3DIM Tool estimates the maximum annual savings in [%], which can be achieved by
using AstroDIM. This estimation is based on the assumption that the ECG is operated
according to the ideal night as it is displayed within the AstroDIM night lapse visualisa-
tion and the minimum dimming level is above or equal the Physical Min Level

Savings per year up to 10 %

AstroDIM Visualisation

The top graph shows the night sequence over the year at the selected ECG location.
Sunsets are represented by the lower line and sunrises are represented by the upper
line. The night, therefore, corresponds to the enclosed, light orange area.

The arithmetic mean of the night is represented by the yellow line. The darker areas
correspond to the times at which the ECG is operated in the first or second dimming
level.
2 |f the real switch-on / -off times differ from the sunset and sunrise depicted in 3DIM Tool (course of the night visualisation), the dim start
and end may also vary according to this offset. For a detailed description of the AstroDIM behavior, please refer to the 3DIM application
guide. The displayed start- and end times could differ between +/- 2,5 minutes between the uploaded and the downloaded data due to

the convertion accuracy of the ECG. The devices of the PTo family and the OT 65 3DIM the values could differ much more, because
the location data and the reference date could not be stored on those ECGs.
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3DIM Tool 2.3.1 General Operation

Sunrise Middle of the night (yellow) Date mark

Jdan Feb Mar Apr May Jun ‘ Jul Aug Sep Oct Dec
Sunset Dim level (dark) Night (bright)

AstroDIM: Night sequence over the year at the selected ECG location
The date mark shows the sunrise and sunset for a certain day. By default the date

mark is located at the day with the longest night. To display the times for another day,
select the respective date in the “Date” drop-down menu.

Daylight zaving time
Date [zz12.20m ~|

The lower diagram visualizes the ECG behavior on the selected day. The switch-on
and switch-off times are adopted from the chosen date. While adjusting the dimming
sequences it is recommended to check the dimming behavior at the longest and
shortest day of the year. The displayed start and end times for the two dimming levels
will be converted into the ECG programming parameters, which are referenced to the
half operating time (middle of the night; yellow line) for this selected day. The time shift
between midnight (00:00) and the half operating time (middle of the night) vary over
the year and cause a variation of the dimming periods. Therefore changing the date
influences the specific AstroDIM programming parameters stored in ECG.

The displayed start and end times for each dimming level are only valid, if the switch
on and off time for the ECG correspond with sunset and sunrise depicted in the 3DIM
Tool.

Power-on level Dim level 1 Dim level 2

Time on ECG site [hrs]

Middle of the night (yellow)
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General Operation 3DIM Tool 2.3.1

OPTOTRONIC® Config

The features displayed within the “OPTOTRONIC® Config” tab, max. operating cur-
rent setting (CSM), constant lumen output (CLM) and temperature protection module
(TPM) are only settable for OPTOTRONIC® constant-current power supplies.

Note:

It is recommended to finish the OPTOTRONIC® Config settings before setting
AstroDIM and StepDIM parameters, since a variation of the max.operating current
or the constant lumen function could impact the Dim level minimum (percentage).

Current Setting Module (CSM)

Cument Setting Module [C5h)

b aimum rated current 700 s,
M aw. operating current 700 S i
Minimum rated current 350 e
Minimal dimming current 5 i,

!I

LED set protection enabled

The current setting module defines the nominal maximum operating current of the LED
power supply. This current can be set according to the demand and capability of the
LED module(s). Max. operating currents outside the rated range of the power supply
are indicated in red. Within CSM, the following parameters can be configured.

* Max. operating current in [mA]:
The max. operating current can be varied between the minimum rated current and
the maximum rated current in steps of 1 mA. The useable operating current range
varies with the capabilities of the selected ECG. If the max. Operating current is out
of the rated range, it would be displayed in red.

* LEDset Protection enabled:
LEDset is an interface between LED modules and OPTOTRONIC® constant-cur-
rent LED power supplies. It allows setting the output current of the electronic control
gear (ECG) according to the needs of the LED module or LED luminaire. In case
the LEDset interface wiring to the LED module is interrupted, the ECG switches into
LEDset protection mode, thus preventing damaging of the LED module.

This mode can be enabled or disabled by setting the respective checkmark. If the
LEDset port is not used, it is recommended to disable the LEDset protection.

Note:
For a detailed description of LEDset, please refer to the LEDset application guide.
www.osram.com/LEDset
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3DIM Tool 2.3.1 General Operation

Constant Lumen Module (CLM)

— Constant Lumen Module [CLM)

CLM enabled
7a a0 85 90 95| 100 ¥ | %

o wE] 30 0 = kHrs | kHis
[] Set LED module operating time I:I kHrs

The constant lumen feature is utilized to compensate the depreciation of the luminous
flux of a LED module over life time.

The following parameters are used to define the adjustment of the depreciation:

* A checkbox to (de)activate the feature.

* Alook-up table for up to 8 data points consisting of the LED module operation time
in [kHrs] and the relative output level of the max. operating current in [%]. The valid
range for the LED module operating time is 0 to 254 kHrs, for the operating current
output level it is 70 to 100 %.

* A checkbox and input field in [kHrs] for setting the LED module operating time within
the ECG. Only if the checkbox is ticked, the value of the input field is written to the
ECG. The valid range for the LED module operating time is 0 to 254 kHrs.

A new data point is added to the look-up table once a start time in [kHrs] is included; a
data point is deleted once its start time is deleted.

Note:

In case an installed LED module failed or an old one is replaced, the LED operating
time counter needs to be reset. This is done by selecting ,Reset LED module opera-
ting time* within the ,Reset* menu.

CLM and CSM visualisation

Maximum rated current Operating current Max. operating current
~ LED module curent / \
l Em— 700 TrA]
L — [33.1 kHrs] | 841 (ma] |

- I
g \
E \
g
? 350 ! E \
8 7
g | : \
° | \

, \ LED module operating time [kHrs] \

Minimum rated current LED module operating time Data point tool-tip
uploaded to the ECG
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General Operation 3DIM Tool 2.3.1

Note:

The display of the operating current (orange line) is also taking the Power-on level
(set via StepDIM or AstroDIM) into consideration. Thus displays the actual output
current at any time, except where the LEDset interface is used to adjust the output
current.

Temperature Protection Module (TPM)

TPM allows for a two-way protection of the LED module(s) against too high tempera-
tures:

¢ Standard (resistor based)
* Flexible (NTC based)

If Standard (resistor based) setting is selected, the OPTOTRONIC® LED power
supply starts lowering the output level if the resistance is below the start derating
resistance. This linear decreasing (100% to 50%) is carried out until the end derating
resistance. The LED module(s) are switched-off once the resistance undershoots the
switch off derating resistance and switched on again if the resistance exceeds end
derating resistance.

[~ Tempenshuars Prolecion Hodue [TPM] 1~ Temmpenshue Proleclon Hodue [TEM)
(&) Srandud [Tadiitol vahus baiad) ooy
10 Fhisibls [NTC bastad)

.30 kOhi

Sianl ety 630 (1T

End derateg 500 Kithm

S0 5,00 kDb
Swabchoff o 0% 43 kDb ’

[} T T o |

Note:
For selecting the correct resistor for each application please refer to the data sheet
of the OPTOTRONIC® LED power supply.

If the Flexible (NTC based) setting is selected the temperature protection behaviour
can be programmed individually. Therefore the following parameters can be set:

¢ Sensor type:
The used NTC needs to be selected within the respective drop-down menu.
The following NTC are available in 3DIM Tool:
- 10k 5% NCP18XH103J03RB (Naming: NCP18XH103J)
- 15k 3% NCP15XW153E03RC + 390 Ohm (Naming: NCP15XW153E+390 )
- 15k 5% NCP18XW153J03RB (Naming: NCP18XW153J)
- 47k 3% Epcos B57423V2473H062 (Naming: EPCOS B57423V2473H)
¢ Start derating in [°C]:
Starting temperature for the linear decreasing of the output level.
* End derating in [°C]:
Temperature until the output level is decreased. Also temperature at which the LED
module(s) is switched on again, after it has been switched off for over temperature
protection (see next bullet point).

20
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3DIM Tool 2.3.1 General Operation

* Shut off temperature in [°C]:
Temperature at which the LED module(s) is switched off for over temperature
protection.

* Dim level lower limit in [%]:
Output level at “End derating” temperature. The linear decreasing of the output will
be carried out between 100% and the value set within this field.

[~ Termpersture Protecton Modue (TPH] 1 Temperstan Frotecton Hodude [TFM)
) Shancaed [Resstor viskom baoad] 100 |
{5} Pt NTC bassed) \

el hpe HCPIPWFIFIZRD 10 % \

Sl chaabg L] . T '\

Erd devsrg El & \

S lf dmrrge stan ] = C % AT
s b e st E] 8 x

o - T

The monitoring feature of 3DIM Tool provides the possibility to double check the TPM
settings. (See chapter “Monitoring”)

OPTOTRONIC® Config password protection

Since a false setting of the OPTOTRONIC® Config parameters can have severe
consequences on the safety of the luminaire, i.e. damaging the LED module, it is pos-
sible to lock the “OPTOTRONIC® Config” parameters with a four digit (0000 to 9999)
personal identification number (PIN).

This PIN has no influence upon StepDIM or AstroDIM parameters, these can still be
reprogrammed without any restrictions.

If the ECG has been locked with a PIN, an upload and therefore changing the
OPTOTRONIC® Config parameters only works if the correct PIN has been entered in
the PIN field.

Note:
It is only possible to program multiple ECGs if they have the same PIN.

PIN entry field PIN visualization Set/Change PIN

PIN [urlock device] Ei'=E" | SetChangsFIN |

Setting a password

By default the ECG have no password set. The following steps are necessary to lock
the ECG with a PIN.

Step | Activity
1 Click “Set/Change PIN” in the OPTOTRONIC® Config tab.
2 Enter the four digit PIN in the “New PIN” field.
3 Repeat the four digit PIN within the “Confirm PIN” field.
4 Click “Set/Change PIN” within the dialog.
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New PIN [1234 |
Confirm PIN [1234 |
Set/ChangePIN | | ResetPIN | Cancel |

Now OPTOTRONIC® Config parameters within the ECG will be locked with the PIN
after the configuration has been uploaded to the ECG.

Changing a password

Note:
The PIN change is valid after uploading the configuration. Therefore the “old” PIN
still needs to be used for the upload following the PIN change (see Step 1).

Step | Activity

1 Enter the correct PIN in the “PIN (unlock device)” field.
Click “Set/Change PIN” in the OPTOTRONIC® Config tab.
Enter the four digit PIN in the “New PIN” field.

Repeat the four digit PIN within the “Confirm PIN” field.
Click “Set/Change PIN” within the dialog.

albhlw|N

Deleting (resetting) a password

Note:

The PIN reset is valid after uploading the configuration. Therefore the “old” PIN still
needs to be used for the upload following the PIN reset (see Step 1).

Step | Activity

1 Enter the correct PIN in the “PIN (unlock device)” field.
2 Click “Set/Change PIN” in the OPTOTRONIC® Config tab.
3 Click “Reset PIN” within the dialog.

Password visualisation

The PIN visualisation indicates the status of the ECG before and after the upload. The
right lock refers to the state before the upload, the left to the state after the upload.
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PIN state within the
ECG before upload

PIN state after upload

s =&

g The connected ECG(s) are not locked with a PIN. After the upload they
won’t be locked with a PIN either.

L ENEY The connected ECG(s) are not locked with a PIN. After the upload they
will be locked with a PIN.

8 =6 The connected ECG(s) are locked with a PIN. After the upload they will
still be locked with a PIN.

The connected ECG(s) are locked with a PIN. After the upload they won’t
& =
be locked anymore.

Upload/Download

If an upload or download has been triggered, 3DIM Tool first scans for connected
3DIM ECG(s). This scanning process can be tracked within the status bar at the bot-
tom of the software. Once the detection is finished the upload or download is initiated.

Uploading a configuration

Note:

To ensure full compatibility of all configuration files created in the past 3DIM Tool
version 2.2.2 or higher needs to be used. All PCs between which configuration files
are shared need to have 3DIM Tool version 2.2.2 or higher installed.

An upload only works if:

* The ECG selected in the 3DIM ECG drop-down menu is identical to the connec-
ted ECG(s).

¢ All ECG connected are of the same type, version and PIN.

Step | Activity
1 Click “Transfer” - “Upload to ECG” in the menu bar or & in the toolbar.

2 Within the status bar, the progress of the upload can be tracked.
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After the upload is finished, one of three possible confirmation dialogs is displayed.

Upload configuration

Upload to 1 = PTo 50/220-240 30IM.

@ StepDIM- and AstroDIM-parameter upload successful.

Upload confirmation, ECG without OPTOTRONIC® Config features. 3DIM mode as well as StepDIM- and

AstroDIM-parameters uploaded.

I Upload to 12 OT 50/220-240/700 3DIMLT E.
@ StepDIM- and AstroDIM-parameter upload successful.

@ WARNING: OPTOTRONIC Config-parameters not uploaded. (Wrong PIN}

Upload confirmation, ECG with OPTOTRONIC® Config features. Only 3DIM mode as well as StepDIM- and
AstroDIM-parameters uploaded. Parameters of the OPTOTRONIC® config features are not uploaded due to the

wrong pin.

Upload to 12 OT 50/220-240/700 3DIMLT E.

@ StepDIM- and AstroDIM-parameter upload successful.

@ OPTOTROMIC Configparameter upload successful .

Upload confirmation, ECG with OPTOTRONIC® Config features. All parameters uploaded.

Clicking , OK* within the confirmation closes the message, clicking ,Report* opens the

documentation dialog. (See chapter Report.)

Downloading a configuration

Note:
A download only works if just one ECG is connected.

Step | Activity

1 Click “Transfer” - “Download from ECG” in the menu bar or EB in the

toolbar.

2 Within the status bar, the progress of the download can be tracked.

24
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After the download is finished, a confirmation dialog is displayed.

Download configuration

Download 1% 0T 50/220-240/700 3DIMLT E.

@ Parameter download successful.

Download confirmation

Clicking ,OK* within the confirmation closes the message, clicking ,Report“ opens the
documentation dialog. (See chapter Report.)

After the download is finished, the configuration stored within the ECG is visualized in
the user interface. If the OPTOTRONIC® Config parameters of the connected ECG
are locked with a PIN, the PIN visualisation will be displayed as shown here:

PINfuniockdevice] | | (@ =@ [ Set/ChangePIN

This indicates that a PIN needs to be included into the ,PIN (unlock device)” field to
change the OPTOTRONIC® Config parameters of the ECG.

Configuration handling

Saving a configuration
Proceed as follows:

Step | Activity

1 Click “File” > “Save as...” in the menu bar or H in the toolbar.
e | (L) M Lawed o o r@
- i
wine B
@
Uy Dot
]
e
T - I
Myl Smembre DURAM 200 i -
2 Select a folder via the “Save in” drop-down menu and enter a file name

for the configuration.
The file type needs to be “OSRAM - 3DIM (*.3dim)”.

3 Click “Save”
The selected name appears in the header of the 3DIM Tool.

Loading a configuration

Proceed as follows:
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Step | Activity

1 Click “File” = “Load configuration...” in the menu bar or /& in the toolbar.
|
Look v | () My Docamons o

[ =
Docamens  FTesng kestion i

Desbaog

2 Select the folder which contains the configuration file via the “Look in:”
drop-down menu.

3 Open the configuration by double-clicking.
The name of the loaded configuration appears in the header of the 3DIM
Tool.

Note:

A configuration can also be loaded by double-clicking the file within the Windows
Explorer. Thus the configuration will always be loaded in manufacturing mode (see
chapter “Manufacturing mode”).

Monitoring

The “Monitoring” window enables a double check of the TPM settings made (i.e. du-
ring the luminaire testing) within the “OPTOTRONIC® Config” tab.

Note:

The complete monitoring functionality is only available for OPTOTRONIC®
3DIMLT+ devices. Monitoring only works if just one ECG is connected to the DALI
magic hardware interface.

To utilize the monitoring feature of 3DIM Tool proceed as follows:

Step | Activity

1 Connect a 3DIMLT+ device to the DALI magic hardware interface. (See
chapter “Hardware installation”.)

Click “Monitoring” within the menu bar..

The monitoring window opens and the ECG is initialized. Should an error
message occur, please proceed as indicated within the error message.

4 Monitoring of the connected ECG starts and provides the information as
depicted below, a refresh is made every 10 seconds. The status flags

appear grey @ under normal conditions or red ® ifthe respective
state is present.

5 Click “Cancel” to close the monitoring window.
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ECG status flags Monitoring state Elapsed time

Monitoring - OT 50/220-240/700 3DIMLT+ E

onitaring status: read in 01337
Status

LED module thermal shutdown
LED module derating acitve
ECG thermal shutdown

System overload

Open circui

LA N N B B

Short circuit

Temperature Monitoring

Cancel

Temperature behaviour over last 30 minutes
Measured NTC temperature

Temperatures set within TPM

Reset

Reset 3DIM parameters

This reset restores the default configuration of 3DIM mode, StepDIM- and AstroDIM
parameters.

Proceed as follows:

Step | Activity

1 Click “Reset” - “Reset 3DIM parameters” in the menu bar.

2 Confirm the warning dialog by clicking “Yes”.

3 Restart (disconnecting and reconnecting the power supply) the ECG.
Note:
For a detailed description of the default parameters, please refer to the data /
instruction sheet of the utilized ECG.

Delete AstroDIM power-on history

This reset deletes the memory of the operating hours of the last eight nights, which
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Settings

is used to enable the autonomous dimming. The reset is recommended once the
operating location of the ECG changes or if several days lie between reprogramming

and deployment.

Proceed as follows:

Step | Activity

1 Click “Reset” = “Delete AstroDIM power-on history” in the menu bar.

2 Confirm the warning dialog by clicking “Yes”.

3 Restart (disconnecting and reconnecting the power supply) the ECG.

Reset LED module operating time

This reset deletes the “LED module operating time” counter within the ECG. This
feature should be used if the LED module is exchanged with a new one.

Proceed as follows:

Step | Activity

1 Click “Reset” - “Reset LED module operating time” in the menu bar.

2 Confirm the warning dialog by clicking “Yes”.

3 Restart (disconnecting and reconnecting the power supply) the ECG.

Note:

Both the CLM look-up table and the checkmark for (de)activating the CLM function
are not deleted, this has to be done by correcting the respective configuration.

Via the settings menu the appearance of the AstroDIM and StepDIM graphs as well as
certain input methods can be adjusted. Also the 3DIM Tool can be locked in manufac-

turing mode.

Display preferences

Display | Coordinates || M anufacturing mode || Heport|

AstroDIM dizplay
[ Show manth lines

[ Show sunrise and sunset extremes
[ Show all timezones
Diirming graph display
[ Dizplay howr lines
[] Display Dim level aid lines

Save Cancel

AstroDIM graph display

Within the visualisation of the night lapse (in AstroDIM mode) aid lines as well as

28
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sunrise and sunset times can be displayed.
Proceed as follows:

Step | Activity

1 Click “Settings” in the menu bar.
2 Select respective tick mark within the AstroDIM display frame of the “Dis-
play” tab.

3 Click “Save”.

Displaying all time zones

By default only one entry per time zone is visible in the time zone drop-down menu of
the ECG location dialog. (See chapter “AstroDIM mode” - “Creating a location”.) As
an option a complete list of time zones can be displayed.

Proceed as follows:

Step | Activity

1 Click “Settings” in the menu bar.

2 (De)activate “Show all time zones”.
3 Click “Save”.

AstroDIM / StepDIM ECG behaviour display

Depending on personal preferences guidelines for the dimming visualisations can be
displayed.

Proceed as follows:

Step | Activity

1 Click “Settings” in the menu bar.

2 Check the checkbox of the respective guideline within the “Display” tab.
3 Click “Save”.
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Defining coordinate formats

Depending on the source for the ECG operation location in AstroDIM mode, different
input methods for coordinates can be defined.

Display | Coordinates | panufacturing mode | Repart|

(O WGES24 location (e, 4878 23" N, 117 24' 28" E)
(& WG584 decimal location [e.0. 4813977, 11.57447)

Save Cancel

Proceed as follows:

Step | Activity

1 Click “Settings” in the menu bar.

2 Choose decimal or WGS 84 format by setting and removing the tick mark
within “Coordinates” tab.

3 Click “Save”.

Manufacturing mode

To support quality assurance in (luminaire) production 3DIM Tool has a dedicated
“Manufacturing mode”. Here only the possibility to upload a predefined configuration
remains, no parameter changes can be made. “Manufacturing mode” is started via a
dedicated executable, by double-clicking a configuration file (*.3DIM) or manually via
the settings menu.

Within the ,Manufacturing mode* tab it is possible to set upload or download reports
to be mandatory (Confirmation with auto report generation) or optional (Confirmation
without auto report generation). For a detailed description see chapter ,Report®.

Display | Coordinates | Manufacturing mode

[ Activate manufacturing mods

FIM [unlock device] | [ Set/Change PIN

Save Cancel

A four digit (0000 to 9999) personal identification number (PIN) can be used to lock
3DIM Tool in “Manufacturing mode”. This PIN does not need to be identical to the one
protecting the 3DIM Tool OPTOTRONIC® Config parameters.
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(De)Activating manufacturing mode
Proceed as follows:

Step | Activity
1 Click “Settings” in the menu bar.
2 Select “Manufacturing mode” tab.
3 (De)Activate manufacturing mode by setting or removing the tick mark.
4 Click “Save”.

Note:

If the tick mark for (de)activating manufacturing mode is not selectable, a PIN was
used to protect manufacturing mode. Please enter this PIN within the PIN (unlock
device) field to regain control over the manufacturing mode (de)activation.

Setting the manufacturing mode PIN
Proceed as follows:

Step | Activity
1 Click “Settings” in the menu bar.
2 Select “Manufacturing mode” tab.
3 Enter current PIN in the PIN (unlock device) field.
4 Click “Set/Change PIN”.
5 Enter the new four digit PIN in the “New PIN” field.
6 Repeat the new four digit PIN within the “Confirm PIN” field.
7 Click “Set/Change PIN”.
8 Click “Save”.

Deleting manufacturing mode PIN
Proceed as follows:

Step | Activity

1 Click “Settings” in the menu bar.

Select “Manufacturing mode” tab.

Include current PIN in the PIN (unlock device) field.
Click “Set/Change PIN”.

Click “Reset PIN”.

Click “Save”.

|| |W|N

Report

Within the “Report” tab the title (i.e. Company XYZ) as well as the items of report
chapter 1 “General” can be customized (3DIM File Name, Date / Time and PC opera-
tor are fixed). To customize these items proceed as follows:

Step | Activity

1 Click “Settings” within the menu bar

XI1'2013
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Select “Report” tab.

Include a report title into the respective field

activated field.

(De)Activate report entries 4 to 6 and include a description for each

5 Click “Save”.

| Display || Coordinates || Warufacturing mods | Fepart

Repart title |DSF|AM 3DIM Tool Configuration

Repart entry 1 |3D|M File Name

Fieport entry 2 |Date / Time:

Fepoart entry 4 |Luminare
Report entry 5 |F'r0iectName
Report entry B |F'r0iec:t Order Murnber

|
|
|
Feport entry 3 |Dperat0r |
|
|
|

Save Cancel

The activated entries will be available for the user to fill in once a report is being crea-

ted. (See chapter “Report”.)
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Report

3DIM Tool offers the possibility to create a configuration report. Within this report all
used parameters are documented. A report can only be created once a configuration
has been uploaded or downloaded.

To create a report, proceed as follows:

Step | Activity

1 Click “Report” in any upload or download confirmation window.

2 The dialog for providing the general information for the report opens.
(The available fields correspond to the configurations made within the
“Report” tab of the “Settings” menu.)

3 Fill in the empty fields.

FillReportDataFarm Y]
Repart title |DSHAM 3DIM Tadl Configuration |
DIMFleName | cemply> |
Date / Time [ar17/2013 20:38 |
Operator | <emphy> |
Lumiriare [Typea |
Praject Mame |Fln\acl 201301 |
Project Order Nurber |38?554321 |
4 Click ,OK*
Save report Print report

[ Report of the 3DIM / OPTOTRONIC parameters

Save  Print the report ..

OSRAM 3DIM Tool Configuration

OSRAM 3DIM Tool Version: 2.1.0.0

>

1 General

3DIM File Name: [empty]

Date / Time: 4/17/2013 20:38 k|
Operator: [empty]

Luminare: Type A

Project Name: Project 201301

Project Order Number: 987554321

2 Ballasts
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Print report
Reports can be printed via a local or network printer.

Step | Activity
1 Click “Print report...” within the report window.
2 A standard print preview opens up.
3 Set up page and printer acc. to available printing hardware and needed
format.
4 Press “Print document” within the print preview.
Save report

Reports can also be saved as *.htm file, to be viewable with a web browser.

Step

Activity

1

Click “Save” within the report window.

2

Select a folder via the “Save in” drop-down menu and enter a file name
for the configuration.The file type needs to be “Webpage, HTML only
(*.htm;*.html)”, encoding is “Unicode”.

3

LOG Files

Click “Save”.

3DIM Tool creates automatically up to 5.000 LOG files for loading configuration from
the ECG (READReport_YY_MM_DD_hh_mm_ss) and transferring data to the ECG
(WriteReport_YY_MM_DD_hh_mm_ss). If the maximum number of LOG files are
exceeded the older versions would be deleted. Therefore it is recommended to copy
and store regularly the files on a separate file server.

The LOG Files are stored under \MY DOCUMENTS\OSRAM\OSRAM 3DIM Too\LOG\
OLD. The LOG File shows the parameters read from or write to the ECG.

. old 2511,20132 08:05 Dateiordner
§35) 2013 11 25-08.05_22 Log 2511.2013 0810 Microsoft Office E... 13 KB
£ | ReadReport_2013_11_25-08_06_26 25.11.2013 08:06 HTML-Dokument TKB
£ | ReadReport_2013_11_25-08_06_49 25.11.2013 08:08 HTML-Dokument TKB
& | ReadReport_2013 11 25-08_10_36 25.11.2013 08:10 HTML-Dokument TKB
£ | WriteReport_2013_11 25-08_08_57 25.11.2013 D&:08 HTML-Dokument TKB
£ | WriteReport_2013 11 25-08_09_32 2511.2013 08:09 HTML-Dokument TKB
£ | WriteReport_2013 11 25-08 1012 2511.2013 08:10 HTML-Dokument TKB
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General

This chapter describes the best practice of using 3DIM Tool during (luminaire) produc-
tion.

General procedure:
Step | Activity
1 Program ECG(s).

2 Integrate ECG(s) into the luminaire and perform all necessary connec-
tions.
3 Perform luminaire test (functionality and safety).
Note:

For LED luminaire manufacturing steps 1 and 2 need to be performed in the correct
order and should not be interchanged. Otherwise, the LED module will be driven
with maximum possible output current of the ECG (e.g. 700 mA), which could
damage the LED module (i.e. in case of a 350 mA module). Only if the current is set
via LEDset, it is possible to interchange steps 1 and 2.

Installing 3DIM Tool

Proceed as follows:
Step | Activity
1 Double-click the “Setup OSRAM 3DIM Tool 2.3.1.0.0” ZIP file.

2 Within the ZIP folder, double-click the setup file. The installation wizard
appears.

3 Choose “3DIM Tool (manufacturing)” as installation type.

3DIM Toal (ful)

[] 30IM Tool {manufacturing
Shorteut

Documentation

4| m | »

4 Follow the instructions of the installation wizard to complete the setup.

Programming 3DIM ECG(s)

Note:

To ensure full compatibility of all configuration files created in the past 3DIM Tool
version 2.2.2 or higher needs to be used. All PCs between which configuration files
are shared need to have 3DIM Tool version 2.2.2 or higher installed.

For the procedure depicted in the following it is necessary to have a prepared
“*.3dim” file containing the configuration which shall be utilized.

The upload of a configuration to the ECG(s) can be carried out in two ways.
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Uploading a configuration (alternative A):

Step

Activity

1

Double-click the “*.3dim” file which shall be used with the ECG(s).

The 3DIM Tool opens (Manufacturing mode), visualizing the selected
configuration.

Check if the displayed configuration is correct.

Click & within the menu bar, to upload the configuration.

Depending on the configuration within the settings menu (,Manufac-
turing“ tab) a report can or must be created, by clicking ,Report®. (See
chapter ,Report®.)

6

Uploading
Step

Finally confirm upload success with “OK”.

a configuration (alternative B):

Activity

1

Start 3DIM Tool (Manufacturing).

3DIM Tool opens, no particlar configuration is selected.

Click '® and select the configuration which should be utilized.

Check if the displayed configuration is correct.

Click & within the menu bar to upload the configuration.

Depending on the configuration within the settings menu (,Manufaturing®
tab) a report can or must be created, by clicking ,Report”. (See chapter
+Report®.)

Finally confirm upload success with “OK”.
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General error handling

This chapter describes strategies to solve errors which might occur during the utilization of
3DIM Tool.

Should the solutions depicted do not solve the issue please contact the OSRAM customer
service center. To improve and speed up the support it is highly recommended to create a
diagnose file and to provide this along with your inquiry.

Creating a diagnose file
Step | Activity
1 Select “Help” > "About OSRAM 3DIM Tool...” within the menu bar.

Select the “Diagnose” tab.

2

3 Click “Create diagnose file”.

4 Select a folder via the “Save in” drop-down menu and enter a file name.
The file type needs to be “*.ZIP".

5 Click “Save”.

If a failure is detected it is immediately visualized via a popup message at the top of the
user interface.

pml ¥ S

More than one DALI magic connected.

Note:
In the unlikely event of an error message which is not described within the subchap-
ters below, please proceed as follows:

Step | Activity

1 Confirm error message by clicking "OK”.
2 Close 3DIM Tool.

(Optionally save the current configuration before closing the software.)

3 Disconnect the DALI magic hardware interface.

Restart the PC and reconnect the DALI magic hardware interface. Make
sure the DALI magic is connected directly to a USB port of the PC, do not
use a USB hub.

5 Restart 3DIM Tool.

ok | Magic

The firmware of the controller is too old

‘ OSRAM 3DIM ECG  (OT 50/220-240/700 3DIMLT+E

XI1'2013 37



Troubleshooting 3DIM Tool 2.3.1

The firmware of the controller does not have the required version.

This message appears if the firmware version of the DALI magic utilized is not suffici-
ent to support the range of functions of the 3DIM Tool.

Troubleshooting:

Step | Activity
1 Select “Help” > "About OSRAM 3DIM Tool...” within the menu bar.

2 Select the “Firmware update” tab.
3 Click “Browse”.
4

Select the “*.ofw” file (at least v2.18) and click “Open”. The latest firm-
ware version is contained in the “Firmware” subdirectory of the root

directory.

5 Click “Start firmware update”. Confirm the appearing warning message
with “Yes”.

6 After the update is complete, the progress bar stops and the following

message appears:

Send firmware to device
Compare checksum
Checksum ok

Start update

DO MOT unplug the device
Feset device

All LEDs of the DALI magic are switched off.

Disconnect the USB connection between the DALI magic and PC.

Confirm error message with “OK”, possibly a second error message
needs to be confirmed also.

Close 3DIM Tool.
10 Reconnect the DALI magic to the PC and restart 3DIM Tool.

More than one DALI magic connected.

This occurs if two or more DALI magic are connected to the PC.
Troubleshooting:

Step | Activity

1 Disconnect the USB connection of the DALI magic which is not utilized
for programming the ECG(s).

2 Confirm error message with “OK”.

Upload failed. The connected ECG differs from the 3DIM Tool selection.

This occurs if 3DIM ECG selected within the “3DIM ECG” drop-down menu does not
match with the connected ECG(s).

Troubleshooting:
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Step | Activity

1 Check which ECG type has been connected to the DALI magic.
Select the same ECG type within the “3DIM ECG” drop-down menu.

Double-check if the current configuration is suitable for the utilized ECG.

Confirm error message with “OK”.

a|lbhlw|IN

Repeat the upload process.

Communication failures

The following communication errors can occur:
* Download failed

¢ Upload failed

* Reset failed

* Reading GTIN failed

¢ Addressing of ballasts failed

* Searching for ballasts failed

* Check Connection (DALI® / mains)

Troubleshooting:

Step | Activity

1 Check ECG power-supply.

2 Check DALI® wiring between ECG(s) and DALI magic

3 Disconnect and reconnect USB connection between DALI magic and PC.
4

Make sure the connected ECG(s) and the ECG selected within the “3DIM
ECG” drop-down menu match.

¢,

Confirm error message with “OK”.

6 Repeat the upload, download or reset process.

Unknown ECG

Only OSRAM 3DIM ECG can be programmed with the 3DIM Tool. If another kind of
ECG(s) is connected, the 3DIM Tool will stop the upload, download or reset.

Troubleshooting:
Step | Activity
1 Disconnect ECG(s).
2 Confirm error message with “OK”.
3 Only proceed using 3DIM Tool with OSRAM 3DIM ECG(s).

More than X device(s) connected.

3DIM Tool stops the current process, if too many ECG(s) for the initiated process are
connected.

Depending on the chosen DALI magic power-supply either a maximum of 4 (internal
power-supply) or 64 (external power-supply) devices can be programmed simultane-
ously.

XI1'2013
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A configuration download can only be triggered if just one 3DIM ECG is connected.
Troubleshooting:

Step

Activity

1

Upload: Disconnect all ECGs except 4 (internal power-supply) respective
64 (external power-supply).

Download: Disconnect all ECGs except one.

Confirm error message with “OK”.

Repeat upload, download or reset.

DALI short circuit.

This failure has two possible reasons, either a short circuit within the DALI® fine or too
many connected ECGs.

To resolve this issue proceed as follows:

Step | Activity
1 Check DALI® wiring and remove potential short circuits between the two
DALI® lines.
2 Check if only the allowed amount of ECGs is connected:

* 4 if the internal power-supply of the DALI magic is used
* 64 if the external power-supply is used

Disconnect and reconnect the DALI magic USB connection.

Confirm error message with “OK”.
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